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LUCRAREA 3. Tehnoredactarea computerizata a unui document
complex. Microsoft Word - partea a 2-a

Tema 1: Antet si subsol (Header & Footer)

1.1. Lansati Microsoft Word g1 creatt un nou document. Introduceti ca titlu textul "Laborator
Microsoft Word" (pe primul rand), 1ar pentru a completa continutul scrieti pe urmétorul rand:
=lorem(10,20)

urmat de tasta Enter.

Precizare: textul "=lorem(p,1)" (fard ghilimele) urmat de tasta Enter introduce un text generat automat
de Word, text format din p paragrafe, fiecare avand / linii. Aceastd functie este activd doar daca este
bifatd optiunea Replace text as you type din tab-ul AutoCorrect (meniul File -> Options -> Proofing
-> AutoCorrect Options).

1.2. Editati antetul documentului (H eader) folosind meniul Insert -> butonul Header $1 introduceti in
aceastd zond urmatorul text (informatiile dintre parantezele drepte [...] se obtin automat folosind
butoanele din submeniul Design, activ dacd ne aflim in modul de editare a antetului/subsolului):
[File Name] creat in ziua de [Date] la [Time] s1 actualizat la [Date], ora [Time]
Editati apoi subsolul documentului (Footer) si inserati textul:
Pag. [Page Number| din [Total no. of Fages|

Exemplu:

Document] creat in ziva de I martie 2015 la 12:00 s1 actualizat la 10 martie 2013, ora 22:00

Pag. 1 din 3

Ce optiune trebuie aleasd astfel incdt sa se modifice automat data si ora actualizirii documentului?
R:
Meniul Insert -> grupul Header & Footer, butonul Header sau Footer, se alege comanda Edit Header
/ Edit Footer. Se folosesc butoanele Page Number (pentru numadrul curent al paginii), Date & Time
(pentru datd s1 ord) st Document Info -> File Name (pentru numele figierulut). Vizualizati (butonul
Document Info) si alte proprietati care se pot introduce atdt in zonele speciale header/footer, cat si
oriunde In corpul documentului. Folosind comanda Document Info ->> Field se pot insera data salvari
(SaveDate) s1 numarul total de pagini (NumPages).

T
= N Field X
‘ ‘ | i ] Please choose a field Field properties ——————————— Field options

] | -
----- — = Categories: Date formats: I™ Use the Hijri/Lunar calendar

Header Footer Page [Date and Time =

N b T I Use the Saka Era calendar
umber = : marti, 01 martie 2016
. = 01 martie 2016 I™ Use the Um-al-Qura calendar
Header & Footer Date 01.03.16 L

EditTime 20160301

PrintDate 1 -mar.-16

SAREDALE 01/03/2016

e 01 mar, 16
01/03/16
martie 16
mar.-16
01.03.2016 12:45
01.03.2016 12:45:39
12:45
12:45:39
[12:45
[12:45:39

“‘l ;! T Preserve formatting during updates
Description:
The date the document was created
Field Codes I Cancel

Tema 2: Nota de subsol (Footnote)
Introduceti o notd de subsol la sfarsitul titlului "Laborator Microsoft Word" (aflat pe primul rand al
documentului) care si contind textul:

Program din suita Microsoft Office

Nota de subsol va contine un hyperlink citre adresa Web http://office microsoft.com/.
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Ce alte optiuni sunt disponibile pentru formatarea notelor de subsol ?

R:

Nota de subsol se infroduce din meniul References -> grupul Footnotes. Pentru inserare cu optiuni
implicite se foloseste butonul Insert Footnote, 1ar pentru optiuni avansate se apasi pe sfigeata = din
coltul dreapta-jos sau se foloseste comanda Note Options din meniul contextual al notei de subsol.

1 ||.|;|_';'|Ir1:ert Endnote 21
AB AB Next Footnote = Location
Insert
Footnote [m Show Notes i Paste Options: + Foobnotes:| !Bgttgm of page j
Footnotes IF] e £ Endnotes: IEi'.-J of docurent ;l
U Convert... |
A Font.. Formmat
=q Paragraph Mumber Format: ilJ e A _VJ
style.. Cuskom marks I— Symbal. .. |
Go to Footnote Start at: m
Mote Options.., Nurnbering: ICDntinuuus j
Convert to Endnote Apply changes
IE Define Apply changes to: !Whnle document _vJ
@ Search with Bing ILHSTI Canicel Apply |

Optiuni principale:
- ghl - liste numerotate 1, 2, 3... ; a, b, c... ; 1, ii, iil... sau elemente marcate printr-un caracter
{exemplu: asterisk *, plus +, simboluri speciale ¢,  etc.);
- numirul de la care incepe numerotarea ¢ tipul ei {continud sau cu reinitializare la fiecare
pagind);
- adaptare la macheta documentului (pe una sau mai multe coloane).

Tema 3: Schimbare majuscule / minuscule { Change Case)

Schimbati automat toate literele din ultimul paragraf succesiv in majuscule, apoi in minuscule. Ce
alte optiuni sunt disponibile?

R

Meniul Home -> grupul Font, butonul Change Case. Se alege JPPERCASE, apoi lowercase. Alte
optiuni: Sentence case, Capitalize Each Word, tOGGLE cASE.

e Change Case
Calibri(Body) ~(11 ~|A A Aa- - 2]
(" Sentence case,
B I U -axx, x " lowercase
, ~ UPBERCASE
ont S i
(" Capitalize Each Word

(" tOGGLE cASE

o] § i Cancel l

Tema 4: Liste (Buliets, Numbering)
Numerotati automat paragrafele 2-10 ale documentului folosind un stil de numerotare la alegere. Cit
sunt distantele implicite pentru alinierea textului listei (aliniatul numérului @ al textului)? Aliniati
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numarul la 0,3 em fatd de marginea din stinga a paginii, 1ar textul listei la 0,2 em. Observati si celelalte
opfium cu privire la formatarea listelor (Bullets, Numbering).

R:

Meniul Home -> grupul Paragraph, butonul Numbering (crearea unei liste numerotate). Distantele
fatd de marginea stdnga a paginii / coloanei se pot modifica apoi din meniul contextual (click dreapta
pe textul din paragraf) alegind comanda Adjust List Idents (Number position: 0,3 cm, Text indent:
0,2 cm) sau din meniul Home -> grupul Paragraf -> sigeata = (Firstline: 0,1 cm, Left: 0,2 cm). Pentru
liste neordonate se observi marcajele disponibile (mici imagini, simboluri sau orice alt caracter).

= = i I al
— v i— ¥ 33—~ = 3= o

L9 || aaBbeeDe .

Recently Used Number Formats = |

» Paste Options:

: A
2 B
3 C.

Numbering Library

1 1)
None < 2)
3 3)
L. A a)
1. B. b)
M. C. )
v
& Change List Level b
Define New Number Format...
¥ Set Mumbering Value...
Paragraph ﬂm
Indents and Spacing | Line and Page Breaks |
General
Dutline lavel: IBodyText vI [T collapsed by defauit
Indentation
Left: |0,2 cm 5‘ Special: By:

Right: foem = | Firstline | forem =

[ Mirror indents

Spacing

Before: IU pt E‘ Line spacing: At
After: et = | Muttiple x| s =

¥ Don'tadd space between paragraphs of the same style

Preview

Srtipln Tien Sl Teont Smipl T

Tabs... Set As Default | OK I Cancel

e
(B

|

Adjust List Indents...

—| Continue Numbering

Set Numbering Value..,

A Font.,

= Paragraph..,

Ig Define

Synonyms b

Translate

Fe
St

Search with Bing

I
8

[i3]

Hyperlink...

| 8

.

New Comment

i

Number position:

|D,3 cm E

Text indent:

|O,2 m 3"

Follow number with:
|Tatr character ﬂ
[ Add tab stop at:

oK I Cancel |
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Tema 5: Efecte vizuale: majusculi incorporata (Drop Cap), efecte pe text (Text Effects)

5.1. Pentru prima literd a primului paragraf aplicati un efect de majusculd incorporatd (Zrop Cap).
Alegeti un alt font (de exemplu, Algerian), dimensiune 90 pt., intindere pe 5 limi, distanti fatd de text
0.3 cm (ca in imaginea de mai jos).

orem ipsum dolor sit amet, consectetuer adipiscing elit. Maecenas porttitor congue
massa. Fusce posuere, magna sed pulvinar ultricies, purus lectus malesuada libero, sit
amet commodo magna eros quis urna. Nunc viverra imperdiet enim. Fusce est. Vivamus
a tellus. Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac
é turpis egestas. Proin pharetra nonummy pede. Mauris et orci. Aenean nec lorem. In
porttitor. Donec laoreet nonummy augue. Suspendisse dui purus, scelerisque at, vulputate vitae,
pretium mattis. nunc. Mauris eget neque at sem venenatis eleifend. Ut nonummy. Fusce aliquet pede
non pede. Suspendisse dapibus lorem pellentesque magna. Integer nulla. Donec blandit feugiat ligula.
Donec hendrerit, felis et imperdiet euismod. purus ipsum pretium metus, in lacinia nulla nisl eget
sapien.
R:
Inzerarea unei majuscule incorporate se face din meniul Insert -> grupul Text, butonul Drop Cap.

5.2, Aplicati majusculei incorporate de mai sus un efect vizual la nivel de text, modificind diverse
proprietati (Cutline, Shadow, Reflection, Glow).

R:

Meniul Home -> grupul Font, butonul Text Effects and Typography.

Calibri (Body) =11 ~| A" A |[Aa- | % = -i=-%-. | & 3= | 4, f
B F U -~apex, o EEY-A-B===|1=. | &-

AAAAA —

A A )

-

Ja Qutline »
& Shadow v
& Reflection *
B Glow 3
123 Number Styles 4
ﬁ Ligatures L4
abe  Stylistic Sets 3

Tema 6: Simboluri (Symbol)
Introduceti urmétoarel e expresii folosind simboluri:
ax’+bx+c=0 A=b-4ac x, ,= (bx A/ (2-9)

T(K) = T(°C) +273,15 1 € [100, +<w0) 1£=161$=127¢€

WVizualizati si alte simboluri disponibile in fonturile Webdings sau Wingdings.
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R.

Meniul Insert -> grupul Symbols, butonul Symbol. In caseta Font se folosesc simboluri din categoria

(normal text) sau fontul Symbol.

T[ | =
ga—' -L | Symbols I Special Charactersl
Equation Symbol | Embed Eont: [symbol =
) - Yigeo i"ZXI@'+iE=.‘—J:J
YME v o § t s i
’ I R p|® DD NnuiDolc|clcle|e
, € £ ¥ © V’c:@@TMfo-—.,»\v<3<:ﬂ:>Ug_J
& = w ol @™z (UL UG
Recently used symbols:
>+ x| [NIa[SIs[s [a[e[£[¥[c B[ =]#]<]5]
i__;: _glc:r-':'E_. mbols... g:ni-lc:odl:elr;me: Character code:l].?ﬁ from‘.lSymbol[decimaljﬂ
AutoCorrect.., | Shorteut Key... l Shortout key:
Insert I Cancel |
e

Tema 7: Chenare (Borders), culori umplere (Shading)

Stabiliti pentru primul paragraf din document urmatoarele proprietati:
- chenare (Borders) la toate cele 4 laturi (Left, Right, Top, Bottom), de culoare albastru (Blue)

s1 grosime 2% pt.;

- culoare de umplere (Shading): Gold, Accent 4, Lighter 80% (finefi mouse-ul pe culoare pentru

a obtine numele e1).

Pentru toatd pagina stabiliti la alegere un tip de chenar g1 modificati diverse proprietiti. Observafi

optiunea Art.
R:

AaBbCcDc AaBbCc

I + | A& TNormal | T No Spa

Paragraph Bottom Border
Top Border
Left Border

----- Right Border

No Border

tH  All Borders

[#] Outside Borders

Inside Borders

Inside Horizontal Border

Inside Vertical Border

.'-I'(-

Honzontal Line
Draw Table

View Gridlines

S M B

Borders and Shading...

Meniul Home -> grupul Paragraph.
Din caseta derulanti a butonulu
Borders se alege comanda Borders and
Shading..., apoi se modifica optiunile
din tab-ul Borders, respectiv Shading.
Pentru a aplica rapid o culoare de
umplere ge poate folosi g1 butonul
Shading (memul Home -=> grupul
Paragraph), insé fard posibilitatea de a
aplica un eventual model (Pattern) pe
fundal.

Din aceeagi fereastrdi Borders and
Shading, tab-ul Page Border, se pot
aplica diverse chenare pentru intreaga
pagind (se pot modifica stilul de lime,
culoarea g1 grosimea). Suplimentar se
poate aplica un model de contur
(optiunea Art).
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Borders and Shading

. L= 1 =i
— . — v A—w =

= | 2l | 9
g - : 3 AaBbCcDc A Borders  Page Border | Shading I

=A== (== 4 T | — T =
= == —" V. B T Normal © 11 Style: Preview

EI i Click: on diagram below or
Hone use buttons to apply borders

Theme Colors

H EN B

Paragraph

| D

LT R
]
El

Lolorn

3-D
o I Automatic vl

Standard Colc

BC . EEEN Width:
Recent Colors Custom 1 pt -
. Apply to:
Art: |Who|e document ll
No Color | none| |
o f & Options... |
v More Colors..,
oK I Cancel I

Tema 8: Verificarea ortografiei si a gramaticii (Spelling & Grammar)

in ce limba este declarat a fi scris textul din documentul curent? Stabiliti limba engleza pentru tot
textul din document. De ce anmmte cuvinte din document sunt subliniate cu o linie ondulat rosie?
Existd cuvinte sublimate cu o Juu plat astrd sau o linie ondulatd verde? Stabiliti apo1 limba
roménd pentru tot textul din docu:ment §1 obser\ratl dacé apar modifican in procesul de verificare
ortograficd/sintactica.

R:

in functie de setarile de la instalarea Microsoft Office, limba implicitd in care este scris un text este
de obicel engleza (apare numele English pe Status Bar, in partea de jos a ferestrei Word). Verificarea
ortograficd g1 gramaticald funcfioneaza corect doar daca textul din document este scris intr-o limba
corelatd cu limba declarati (de exemplu, pentru text scrig in roménd trebuie stabilitd limba roménd).
In caz contrar, cuvintele nu vor fi gasite in dictionarul limbii declarate si vor fi subliniate.

Stabilire imba: meniul Review -> grupul Language, butonul Language. Alte butoane utile pentru
functia de verificare a textului: memiul Review -> grupul Proofing, butoanele Spelling & Grammar,
Thesaurus g1 Define.

ABC IE ABC £ i, -
v EE 123 | 9% AT 7
spelling & Define Thesaurus Word | Translate Language New

Grammar Count - - Comment

Proofing Lang 7 Set Proofing Language...

Linie rosie - probleme de ortografie (cuvinte scrise gregit sau cuvinte inexistente in dicionarul limbii
stabilite, cuvinte repetate etc.). In meniul contextual (click dreapta pe cuvéntul evidentiat) se
sugereazid cuvinte apropiate sau existd posibilitatea de a adfiuga acel cuvént la dictionare propri
(Custom Dictionaries).

Linme albastrd - probleme gramaticale (dezacorduri, punctuatie, structura frazei, cuvinte folosite
incorect, constructu fard sens, spafiere intre cuvinte / fraze) sau de stil (colocvial - jargon, despéarfire
in silabe, lungimea gi structura frazei, lipsa conciziei g1 a clarititi, alte sugestii privind stilul scrierii).
in Office 2010, o evidentiere cu linie verde indica o eroare contextuald (utilizarea gresitd in acel
context a unwi cuvant scris corect).

"Lorem ipsum" este un text generat automat, folosit in desktop publishing pentru umplerea machetei
(layouf) unm text tipant, document electromic, site Web etc. Textul este format prin amestecarea
cuvintelor (caractere addugate sau eliminate) intr-o aparents limba latind, insi incorectd g1 fird sens.

6
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In concluzie, textul nu va putea fi declarat ca fiind scris in vreo limba, iar cuvintele subliniate vor fi
evidentiate ca incorecte. La stabilirea limbii engleze: cuvéntul "Laborator" din titlul documentului
este sublimat cu rosu (nu existd in dictionarul limbii engleze), problema rezolvatd prin selectarea
limbii roméne ca limbd a acestui cuvant. Dupd stabilirea limbii roméne pentru tot textul
documentului, observati anumite cuvinte care nu sunt subliniate deoarece se regasesc (dinintdmplare)
in dictionarul limbii roméne.

Tema 9: Gasire si inlocuire text (Find, Replace)

Cautafi In document cuvéntul "mauris". De céte ori apare acest cuvant? Dar cuvantul "Mauris" (scris
cu prima literd majuscula)? Inlocuifi acest ultim cuvant (se va tine cont de litere mari/mici) cu
"MAURIS".

R:
Meniul Home -> grupul Editing, butonul Find. Cuvantul "mauris" apare de 14 ori, iar "Mauris" de 8
ori (folosind sdgeata din dreapta butonului Find / casetel Find se alege Options sau Advanced Find §1
se bifeaza optiunea AMafch case). Inlocuirea se realizeazi cu comanda Replace pastrind bifata
optiunea Match case.

#% Find -
AaBbCcDt Ac AaBbCcDc AaBbCcDt Ac AABBCCDL AABBCCDL AaBbCcDe 3
¥ “ac Replace
Emphasis Intense E... strong Quote Intense Q... SubtleRef... IntenseRe.. BookTitle |+||
ki Select~
Styles [ Editing
Find and Replace '_ _ﬂ
Find |Reg|acei GoTo I
Find what: il\ﬂauris LI
Options: Match Case
<= Less | Reading Highlight = FindIn = I Eind Mext I Cancel
Search Options
Search: lAII Vi
v Match case ™ Match prefix
™ Find whole wards only 1 | Match suffix
™ Use wildcards
™ Sounds like [English) o Ignore punctuation characters
™ Find all word forms [English) ] Ignore white-space characters
Find
Format = l Special Mo Formatting

Tema 10: Tabele (Tables)

10.1. Creafi un nou document. Degchideti figierul tabel.txt (de tip text) din folderul curent si observati
confirmarea la conversie. Ce format de codare (Encoding) ar trebui ales? Dupa deschidere, copiati tot
continutul figierulu text in noul document creat.

R:

Selectati Unicode (UTF-8) ca tip de codare (de altfel, tip detectat automat de catre Word).
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File Conversion - tabelbct EB

Select the encoding that makes your document readable,

Text encoding:

(" Windows (Default) i M5-DOS o Other encoding:  [Turkish (Windows) ;I
Ukrainian [Mac)

Unicode

Unicode (Big-Endian} _I
Unicode (UTF-T

Preview:
Zn Seria Grupa Numdr studenti MEDIE -
1A 411n 28
41zn 24
413R 28
414R 26
B 411B 26
412B 24
413B 24
414B 25
C 411C 27
41zC 27
|

T
OK I Cancel I

P

10.2. Convertiti acest text in format de tabel folosind meniul Insert -= Table -> Convert Text to Table.
Ce caracter considerati cd delimiteazd coloanele?

R:

Se selecteaza tot textul introdus (Ctrl+A) si se converteste sub forma de tabel folosind caracterul
spatiu (space) ca element separator pentru coloane (in caseta Other se tasteaza un spatiu).

Convert Text to Table E !3 |

Table size

Number of columns: |6 5‘
AutoFit behavior

(* Fixed column width: |-luto 5‘

" AutoFit to contents

" AutoFit to window

Separate text at
" Paragraphs ( Semicolons

 Tabs & other [

| oK I Cancel I

Dupa conversie, pentru a obtine o structurd similard cu cea din tabelul de mai jos se vor efectua
operatii de imbinare a celulelor (Merge Cells) folosind butonul corespunzator din meniul Table Tools
-> Layout (activat cand se da click in tabel).

10.3. Pentru tabelul creat aplicafi:

- font: Calibri, 10 pt.;

- indltimea primei limi: 2 cm;

- latimea primei coloane: 1 cm, iar a coloanelor 2...5: 1" (inch);

- alinierea tabelului: pe centrul paginii;

- alinierea textului in celule: centru (onizontald), mijloc (verticald),
- culoarea de umplere a ultimei coloane: Green, Accent 6, Lighter 80%.
Pentru prima linie (antetul tabelului):

- font bold;

- directie verticald;

- culoarea Green, Accent 6, Darker 50%.
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m - o
z s : 8 2
L (G z 3 2

4114 26

i 4124 24

41348 26

4144 26

4118 26

B 4128 24

4138 24

414B 23

411cC 27

412C 27

& 413C 24

414cC 25

! 411D 36

. 412D 76

413D 28

4140 26

411E 28

£ 41ZE 26

413E 27

414E 27

411F 26

412F 25

i 413F 25

414F 25

R:

Table Properties X I

i| Row | comwmn| cen | e |
Size
I Preferred width: m = Me I'_a, et j
Alignment
Indent from left
Eli ﬁ ﬂ |I a1 a:
Left Center Right
Text wrapping
H ||
Hone Around
Borders and Shading... | Dptions... |

[ o 1]

Cancel |

Se folosesc butoanele si optiunile din
submeniurile Design sau Layout
corespunziitoare meniului  Table
Tools (activat cind se di click in
tabel) sau sigeata = din coltul
dreapta-jos al grupului Cell Size.

Dimensiuni limi / ¢oloane: Layout -»
Cell S1ze -= Width, Height

Aliniere text: Layout -> Alignment -
= Align Center

Directie text: Layout -= Alignment -
= Text Direction

Culoare text: Home -= Font -> Font
Color

Chenare: Home -= Paragraph -=
Borders sau Table Tools -= Design -
= Borders

Culoare fundal celuli: Home -=
Paragraph -> Shading sau Table
Tools - Design -= Shading
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10.4. Adaugati la sfarsitul tabelului o noud linie cu urmétorul continut:

An
Seria
Grupa
Numdr
studenti
MEDIE

| TOTA-LGENERAL: - | | |

Introduceti in celulele de pe ultima coloané, pe fiecare din cele 6 linii, céte un cdmp de tip formuld
matematicii { Forruda) care si calculeze automat media aritmeticd a numérului de studenti, pe serii.
Introduceti pe ultima linie, in celulele corespunzitoare, suma studentilor inmatriculati in anul 1 si
media aritmeticd a numerelor de studenti de la toate grupele, cu 3 zecimale. Modificati la alegere
numérul studentilor de la una din grupe. De ce rezultatele formulelor {(media pe serie, num arul total
al studentilor si media generald) nu se actualizeazi?

R:

Inserare linie dedesubt: Layout -= Rows & Columns -> Insert Below sau se apasi in tabel tasta Tab
pénd cursorul trece pe o linie noud.

Inserare formuld matematici: meniul Table Tools -== Layout, butonul Formula. Identificarea celulelor
se face folosind litera coloanei g1 num &rul liniei (celula din stdnga-sus este A1, apoi pe orizontald B1,
Cl,..., iar pe verticald A2, A3, .... Ca parametri ai functitlor se pot folosi constante, operatori
matematici, unul sau mai multe nume de celule (separate prin "." - virguli) sau intervale de celule
{specitficate prin ":" - doud puncte).

Formula ﬂ x|

Formula:
|-AvERAGE(D2:DS)

HNumber format:

I i

Paste function: Paste boakmark

I N £
OK I Cancel |

Pentru mediile pe serii se foloseste formula =AVER AGE{celula start:celula finala) pe grupurile de
celule D2:D35, D6:D9, D10:D13, D14:D17, D18:D21, D22:D25.

Pentru totalul general se folosesc formulele:

=SUM(D2:D25) s =SUM(ABOVE)

respectiv

=AVERAGE(D2:D235), specificindu-se la Number format: #,##5 (pentru 3 zecimale)

Aceste cAmpuri se actualizeazd doar manual (la click dreapta pe cémp se alege comanda LUpdate

Figld).

10.5. Copiati informatiile din coloanele 3-4 (fird ultima linie) intr-un nou tabel si sortati datele:

- alfabetic dupa grupd;

- descrescitor dupd numérul studentilor;

- crescéitor dupd numfrul studentilor SI (SIMULT AN) alfabetic dupi grupi.
R:
Sortare: meniul Table Tools -= submeniul Layout, grupul Data, butonul Sort sau meniul Home -=
grupul Paragraph, butonul Sort. Se pot alege 1, 2 sau maxim 3 criterii de sortare simultan. Sortarea
se face intdi dupé primul criteriu, iar pentru elemente identice, dupi al doilea criteriu {daci acesta

10
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este specificat). In final, pentru elemente identice in urma sortarii dupa primele 2 criterii, ordonarea
se poate face dupd un al treilea criterin, daca este specificat. Campurile de ordonare (coloanele
tabelului) sunt identificate automat de tip Text, Number sau Date, iar ordonarea se poate face
crescitor (in sens alfabetic A-Z) sau descrescitor (Z-A).

Sort 21 x]
Sort by
|Numérs‘tudem| ;l Type: INumuer :_! (" Ascending

Y :
Using: IParagraphs _Ll Descending

Then by
|Grupa x| Tyoe IText :J % Ascending
Using: |Paragraphs | € Descending
Then by
| x| Type: IText ‘:I ¥ Ascending
Using: [Paragraphs =| ¢ Descending
My list has
& Heatiarsg " Noheath

Options... | oK I Cancel

Tema 11: Imagini (Pictures)
Creati un nou document s1 inserati o imagine de pe discul local sau, daca exista conexiune la Internet,
o imagine online (fiec folosind motorul de cautare Bing, fie din conturile OneDrive, Facebook sau
Flickr).
- Redimensionati proportional imaginea la o latime (width) de 4 em.
- Generati un text folosind expresia "=lorem(10,10)" s1 asezati imaginea in mijlocul paginii,
inconjurata de text.
- Vizualizati efectele ce se pot aplica imaginii: luminozitatea, contrastul, saturatia, tonurile de
culoare; aplicati si modificati stiluri g1 efecte artistice.
- Decupati o portiune din imagine.
- Rotiti imaginea ramasa cu 45 grade spre stinga.
R:
Din meniul Insert -> grupul Illustrations, butoanele Pictures (pentru imagini stocate pe discul local
sau in reteaua locald) sau Online Pictures (pentru imagini online).

i bd @ B Ml Al

Pictures Online Shapes SmartArt Chart Screenshot
Pictures - >

INustrations

Operatii cu imagini: meniul Picture Tools -> submeniul Format:
- grupul Adjust, butoanele Corrections, Color, Artistic Effects;
- grupul Picture Styles, butonul Picture Effects;
- grupul Arrange, butoanele Position, Wrap Text, Rotate;
- grupul Size, butonul Crop, casetele Height, Width.

3] Documentl - Word PICTURE TOOLS
FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW DEVELOPER Acrobat FORMAT
. = Tl Compress Pictures po— ey e g ———— L7 Picture Border =
| [
- == % Change Picture sl | el a sl = Q . ] ot sl | |~ | (B Picture Effacts =
Sl g — —
Remove | Corrections Color Artistic —_— — — = ==

Background . Effects - I Reset Picture - * | BL Picture Layout ~

Adjust Picture Styles 5

11
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?2 @

.\_1 ix .1 Bring Forward ~ |2 Align~ ‘..x~ %D Height: |7,33 cm
p ,t,'J W 1 Send Backward ~ [ (_F ,
osition Wra ) B :
i TextFi E{,, Selection Pane “A Rotate ~ U ens Width: 955cm 2

Arrange Size I
Tema 12: Forme (Shapes)

12.1. Introduceti 5 cercuri cu urmitoarele proprietiti: raza de 1,5 em, grosimea chenarului 6 pt. si
culoarea de umplere aceeasi cu a chenarului, avand o transparenti de 80%.

Efectuati urmitoarele operatii:

- adaugati text celor 5 cercuri — cifrele 1...5 scrise cu font Verdana, dimensiune 25 pt., stil

ingrosat (Bold), de aceeasi culoare cu a chenarului;

- aliniati obiectele intre ele, pe orizontald gi verticala;

- distribuiti obiectele intre cle (astfel incat distanfa dintre ele pe orizontala sa fie aceeasi);

- ordonati obiectele pe niveluri (straturi), plasand cercurile deasupra sau dedesubtul celorlalte,

conform modelului de mai sus;

- grupati cele 5 cercuri intr-un singur obiect;

- aliniati grupul creat pe centru, relativ la pagina.
R:
Din meniul Insert -> grupul Ilustrations, butonul Shapes se alege forma Oval (Basic Shapes) g1 se
tine apasatd tasta Shift pentru a crea un cerc. Pentru formatare se folosesc butoanele din meniul
Drawing Tools -> Format (Width = Height = 3 em. Shape Outline si Shape Fill). Adaugare text: click
dreapta pe cerc s1 Add Text.
Pentru aliniere, distribuire, grupare obiecte:
- intai se selecteaza obiectele folosind comanda Select (meniul Home -> grupul Editing -> Select ->
Select Objects) sau prin click pe primul obiect urmat de Shift + click pe al 2-lea, al 3-lea etc.;
- pentru selectia respectivd se folosesc comenzile din butonul Align (Align Center, Align Middle,
Distribute Horizontally) sau din butonul Group. Alinierea se poate face relativ la obiectele selectate,
la margini sau la pagina.
Pentru ordonare obiecte: Bring to Front, Send to Back.

m Documentl - Word DRAWING TOOLS
FILE HOME  INSERT  DESIGN  PAGELAYOUT  REFERENCES  MAIINGS  REVIEW  VIEW  DEVELOPER  Acrobat FORMAT
= L OO O - | < Edit Shape - ? | £2ShapeFill - A Text Fill -
AL Lep L 5|+ | E Draw Text Box | ﬂ lEﬂ - | [¥ Shape Outline - A A - A Text Outline -
BN Y o Ly =) = o |
@ VA W " | & Shape Effects - | (A Text Effects -
Insert Shapes Shape Styles [ WordArt Styles

12
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Il G =

Text Align Create | Position Wrap  Bring Send

Direction~ Text~ Link
Text

2 BB ™

Pictures Online Shapes SmartArt Chart Screenshot | Apps for

Pictures =

Recently Used Shapes

ENNOOOA
CIRYANE SN I
Lines

L 2

Rectangles
OabDOot,

Basic Sh apes

4|_ 'TDF&

N

I’H\IKTIEH\ILUI

? @3
1 [] ‘\ [ I,_‘Alugn N § H Height: (1,5 cm
= — = 1 Group ~
Selection = Width: [1,5em
Text = Forward = Backward ~ Pane Rotate~ | *°3
Arrange Size F
I ’ i Find ~
AaBbCcDi
[ B+ | @ - | 25 Replace
tense Re.. BookTitle |<
; = [+ Select~
b Office ~
l Select All
prey [¥ Select Objects
Select All Text With Similar Formatting (No Data)
E-TL, Selection Pane..
ANER

12.2. Creati o caseta de text (Text Box) de dimensiune 5 cm x 6 cm i generafi in interiorul ei un text
folosind expresia "=lorem(5.4)" urmati de Enter. Aplicati font Calibri, dimensiune 9 pt. Adaugati 2
noi casete de text de aceleasi dimensiuni si creati legaturi intre cele 3 casete, astfel incat textul si le
umple automat (butonul Create Link - a nu se confunda cu Hyperlink, legétura catre o adresa Internet).

Efectuati urmatoarele operatii:

- aplicati culoarea de umplere Light Green (RGB = 204, 255, 204) pentru prima caseta de text

si textura Papyrus pentru ultima caseta;
- modificafi proprietatile liniei de contur pentru a doua caseta (stil, culoare, grosime);
- aplicati o umbra (Shadow) primei casete de text si un efect 3-D ultimei casete.

Lorem ipsum dolor sit amet,
consectetuer adipiscing elit.
Maecenas porttitor congue
massa. Fusce posuere, magna sed
pulvinar ultricies, purus lectus
malesuada libero, sit amet
commodo magna eros quis urna.
Nunc viverra imperdiet enim.

Fusce est. Vivamus a tellus.
Pellentesque habitant morbi
tristique senectus et netus et
malesuada fames ac turpis

egestas. Proin pharetra
nonummy pede.

Mauris et orci. Aenean nec
lorem. In porttitor. Donec
laoreet nonummy augue.

Suspendisse dui purus,
scelerisque at, vulputate vitae,
pretium mattis, nunc. Mauris
eget neque at sem venenatis
eleifend. Ut nonummy. Fusce
aliquet pede non pede.

Suspendisse dapibus lorem
pellentesque magna. Integer
nulla. Donec blandit feugiat
ligula. Donec hendrerit, felis et
imperdiet euismod, purus
ipsum pretium metus, in
lacinia nulla nisl eget sapien.

R:

Cele 3 casete de text se introduc din meniul Insert -> grupul Text, butonul Text Box sau din grupul

[lustrations, butonul Shapes, categoria Basic Shapes -> =

13
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[# signature Line -
F{g Date & Time
Object ~

Jﬂl
=
— —

Text Quick WordArt Drop
Box~ Parts~ . Cap
Text

Legaturile intre cele 3 casete pentru a fi umplute automat cu text se realizeaza cu butonul Create Link
din meniul Drawing Tools {activ la click pe o caseta de text). Pentru formatare se folosesc butoanele
s1 casetele din acelasi memu: Width =5 em, Height = 12 cm, Shape Outline, Shape Fill - More Fill
Colors -> Custom s1 Shape Fill -> Texture, Shape Effects.

3] Documentl - Word DRAWING TOOLS
FILE HOME  INSERT  DESIGN  PAGELAYOUT  REFERENCES  MAIINGS  REVIEW  VIEW  DEVELOPER  Acrobat | FORMAT |
=R | = Edit Shape - —_— —— e ape Fill - | et Fill =
EEN =, Edit Shape Shape Fill = Text Fill
| b raw Text Box = al utline = b ext Outline -
(AT LD L[| EoawTes Abc Abc Abc Abc Abc Abc | [+ [# shape Outli W[+ A Textoutl
| = \ ) ey Fea]
14 €y &[5 |7 @ shape Effects || 17| A Text Effects -
Insert Shapes Shape Styles [F1 WardArt Styles [

[T Align~

I Bl BB W B H

% [[Height [12em 2

E.E'l: Group = .
Text Align Create | Position Wrap  Bring Send  Selection Swnidth: |5 em *
Direction = Text= Link = Text+ Forward~ Backward - Pane - hRotate~ | € ‘:|

Text Arrange Size [

Standard | Custom |

Colors:
"

Color model: IR{;B ]
Green: 255 New
Blue: 204 =

Transparency:

£15| %2 conen

< |

Tema 13: Diagrame complexe (SmartAr)
Creati o diagrama de tipul celei de mai jos.

Task 1
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Adaugafi un nou element, Task 3, intre Task 2 si1 Task 3. Mutati acest element apo1 intre Task 4 s1
Task 1. Observati si alte optiuni in formatarea si prelucrarea unui obiect de tip SmartArt (modificare

layout, culori, stiluri).

R:

Din meniul Insert -> grupul Illustrations, butonul SmartArt se pot alege diverse machete pentru
diagrame complexe (liste, procese, ciclun, 1erarhii, relatii, matrice, piramide etc.). Din meniul
SmartArt Tools, submeniurile Design s1 Format se prelucreaza obiectul respectiv (addugare / stergere

/ mutare element, schimbare macheta, culori, stiluri, pozitionare, dimensiuni etc.).

‘j
-

Pictures Online Shapes SmartArt Chart Screenshot

Pictures
Tlustrations

Choose a SmartArt Graphic

(20

- -
° -
Basic Cycle

Use to represent a continuing sequence
of stages, tasks, or events in a dircular
flow. Emphasizes the stages or steps
rather than the connecting arrows or
flow. Works best with Level 1 text only,

oo |

F Documentl. - Word
ZE HOME  INSERT  DESIGN  PAGELAYOUT  REFERENCES ~ MAIINGS  REVIEW  VIEW  DEVELOPER  Acrobat
71 Add Shape - — ' = c i z
£l = | @B B B 2
[=] Add Bullet b MoveDown || ¢ T | (RN (2 R 290 |-
= EeE = = nE e 5 = | Change
ETedtPane 2 RighttoLeft = : | | Golor~

Create Graphic

Layouts

Tema 14: Grafice (Charf)
Realizati un grafic al datelor statistice din tabelul de mai jos, conform modelulu prezentat.

SMARTART TOOLS

DESIGN FORMAT

Smartart Styles

An Populatia rezidenta la 1 ianuarie | Emigranti la 1 ianuarie
2002 21.83 1.06
2003 21.63 1.15
2004 21.52 1.18
2005 21.38 1.27
2006 21.26 1.35
2007 21.13 1.44
2008 20.64 1.92
2009 20.44 2.14
2010 20.29 2.23
2011 20.2 229
2012 20.1 2.34
2013 20.02 2.34

Sursa; INSSE.ro

15

e
=l

Rese:

“!| Graphic

Reset
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Rezidenti si emigranti

C,I.I.I..l.l.. -|-|- m lm Hm Hm
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30

20
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P

"
Y
S (v}

Vv

W Populatia rezidenta la 1 ianuarie B Emigrantila 1 ianuarie

Efectuati urmétoarele operalii:

- adaugati graficului un titlu, schimbati directia textului pe axele orizontald (inclinatd la 45

grade) si verticala (scris pe verticald).

- alegeti diverse culori pentru reprezentarea graficd, fundal si titlu.

- modificati limitele axei verticale, intre 20 (minim) $i 22 (maxim).
Observati si alte optiuni in formatarea si prelucrarea unui obiect de tip Chart (tipuri de reprezentiri
grafice, proprietatile axclor, formatareca valorilor numerice, fonturi, culort).
R:
Din meniul Insert -> grupul Illustrations, butonul Chart se introduce un obiect de tip grafic, util in
reprezentarea vizuald a unor valori numerice (rapoarte, sinteze, statistici etc.).

Pictures Online Shapes SmartArt Chart Screenshot
Pictures - =

Illustrations

Un obiect de tip Chart confine:

- o zond de date organizati sub forma unei foi de calcul (Spreadsheet) in care valorile introduse (text,
date numerice, formule matematice), pe linii sau pe coloane, stau la baza reprezentirii grafice;

- 0 zond a graficului efectiv 1n care se datele pot fi reprezentate Tn mai multe moduri (tip coloane,
linii, bare, suprafete, "placintd” etc.).

31

Rezidenti si emigranti

30
+.

(= B Chart in Microsoft Word X
g P
A B (= D E F G [«] . &
1 | An | Populatia rezidents la 1 isnuarie Emigranti la 1 ianusrie
o
2 [2002 21,33 l 1,06 a | T
3 |2003 2163 115
4 2008 2152 118 ™ - B B, H. B. B UBu Hs 8= Hs n
5 200 2138 127 TP R S S S S S S
6 2006 21.26 135 F 5 G A
7 il 2148 2 1= W Populatia rezidentd fa 1januarie  m Emigranti 2 1 fanuarie

Pentru a modifica diverse proprictdfi (directia textului pe axe, limitele axei): click pe elementul pe
care dorim sd-1 modificam (titlul, axele, legenda, seriile de date, fundalul) si din meniul contextual se
alege Format.

(3] Document! - Word CHART TOOLS
HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW DEVELOPER Acrobat DESIGN FORMAT

f . pommn L i i
' A= o e g e s SoXes e |J<> 1 e
OE" | ®e® (& = |} : X N Hp) BA
I"‘ = . PHEEEEEEEEE LOLLLAARY i PLOPEEEEE EREERRERERE (HERLLECRRELE SRR T - j =i / - II
Add Chart Quick | Change L IAXEZALT s = = | SwitchRow/ Select Edit | Change
Element ~ Layout~ | Colors~ Column Data Data~ Dat Chart Type
Chart Layouts Chart Styles Data Type
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Tema 15: Text artistic (WordArt)

Introducefi un obiect de tip WordArt. Dupa ce alegetfi stilul s1 textul confinut, particularizati diverse
proprietati ale acestui tip de obiect: chenare, culori de umplere, efecte pe text (umbre, reflexii,
stralucire, orientare 3D, deformare), directie si aliniere.

Your teXt
here

Un obiect de tip Wordart se insereaza din meniul Insert -> grupul Text, butonul Word Art.

m j 4 [# Signature Line ~

- 3 Date & Time
Text Quick WordArt )
Box~ Parts~ - ; [ Object ~

Text
Pentru formatare se folosesc butoanele din meniul Drawing Tools (activat la click pe obiect).

Tema 16: Expresii matematice (Kquation)
Introduceti urmatoarele obiecte de tip expresie matematica:

Ry e N
f(x,u,a)=me 20 = Sm(g) COS(%) f—m—arcsma-l-

R:
Un obiect de tip Equation se insereaza din meniul Insert -> grupul Symbols, butonul Equation.

it Q

Equation Symbol

- -

Symbols

——
E‘ Document itl - Word EQUATION TOOLS

FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW DEVELOPER Acrobat DESIGN

€ i E Tl =iz e 1 x| M el el el S sl <l T=TEz=Te =1 X X N~ “ /
T[ :!-me\-_c it |J—r ‘ o ||= "' ol e | 5 - = | [F] |2 | ‘ =||v] . y (,) ’\"-\. ] 3 ?—‘ {()} sme ('/ ;Ef:frl- =\ [lllli__
: ] ‘ | ‘ z | s 1Tulln]le % ] - Cl| A CIENE) ‘ € | 1‘ e | 1 ‘ —| | Fraction Script Radical Integral Large  Bracket Function Accent Limit and Operator Matrix

Equation A
. ~  Operator= - . Log~

(
abc Normal Text | -

Tools E Symbols Structures

ntrebari

1. O celuld a unui tabel poate avea chenar pe diagonala?

2. Textul dintr-un paragraf poate {i agezat peste un obiect (de exemplu, o imagine)?

3. Se pot scrie cuvinte in engleza dacd am ales curent o altd limba (de exemplu romana)?

R:
1. Da. Se pot stabili individual chenare pe orice laturd (sus, jos, stinga, dreapta) sau pe diagonale, in

orice combinafie.
2. Da, folosind proprictatea Behind Text a unui obiect de tip imagine (butonul Wrap Text din meniul

Picture Tools).
3. Da, insa ele vor fi subliniate cu rosu deoarece nu exista in dictionarul limbii selectate (romana).

17
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